
Final 2 8th  

 
True/False 

Indicate whether the statement is true or false. 

 

____ 1. If a sentence is selected and the Delete key is pressed, the selected sentence will be deleted.  

 
____ 2. To select a sentence, hold down the Alt key and click the sentence. 

 
____ 3. The copyright symbol (©) is placed in a document by pressing the copyright symbol key on the keyboard.  

 
____ 4. An antonym is a word that has an opposite meaning.  

 
____ 5. A left tab stop aligns the end of the text at the tab stop. 

 
____ 6. An example tab leader is ...... 

 
____ 7. A list of features available in a new bicycle should be formatted as a bulleted list.  

 
____ 8. To edit a header, double-click the header area. 

 
____ 9. When a graphic is moved in a document, the text moves to make room for the graphic. 

 
____ 10. A graphic can be recolored. 

 
____ 11. Footnotes appear at the top of the page by default. 

 
____ 12. The title of a Web page is displayed in the title bar of the browser window.  

 
____ 13. Contrast is the difference between the lightness and darkness of two colors.  

 
____ 14. A new presentation contains ten slides. 

 
____ 15. New slides added to a presentation have the Title and Content layout. 

 
____ 16. The text in a slide is best edited in Normal view. 

 
____ 17. The Outline tab can be used to display a specific slide. 

 
____ 18. Headers and footers can be added to the printout of a presentation.  

 
____ 19. Information can be added to the footers of the slides. 

 
____ 20. Slide Master view displays one slide with the Title and Content Layout.  

 
____ 21. The Notes pane can be sized by dragging the top boundary of the pane.  

 
____ 22. The Notes Master is used to change the layout and look of printed speaker notes on all slides.  



 
____ 23. The same transition can be applied to all slides by clicking Animations  Apply to All.  

 
____ 24. When drawing annotations, Ballpoint Pen is one of the choices. 

 
____ 25. PowerPoint includes a variety of sound files. 

 
____ 26. A template is a master publication that includes the basic elements for particular types of publications. 

 
____ 27. Objects include text boxes and graphics. 

 
____ 28. Color can impact the meaning of a publication. 

 
____ 29. Text can be typed directly onto a publication page.  

 
____ 30. Resizing a text box does not affect the wrap of the text in it. 

 
____ 31. Text that does not fit into a text box will not be visible on the page. 

 
____ 32. A text box can be rotated. 

 
____ 33. Scroll bars are used to display hidden parts of the page. 

 
____ 34. The magnification of a publication can be adjusted. 

 
____ 35. Keywords are used to search for specific clip art. 

 
Multiple Choice 

Identify the choice that best completes the statement or answers the question. 

 

____ 36. Which application is used to produce professional-looking documents, such as letters and reports? 

a. Outlook c. Excel 

b. Word d. Access 
 

 

____ 37. Which part of the Word window shows the paper size? 

a. title bar c. rulers 

b. insertion point d. status bar 
 

 

____ 38. In a new Word document, the title bar displays  

a. New. c. Book1. 

b. Document1. d. Word1. 
 

 

____ 39. To correct a misspelled word 

a. click Redo  on the Quick Access Toolbar. 

b. right-click the word, select Ignore Once from the menu, and then retype the word. 

c. right-click the word and then select the correct spelling from the menu. 

d. right-click the word and select Correct Spelling. 
 

 

____ 40. To select an entire sentence,  

a. triple-click any word in the sentence. 



b. double-click any word in the sentence. 

c. press Ctrl and click anywhere in the sentence. 

d. press Shift and click anywhere in the sentence. 
 

 

____ 41. To select text 

a. single-click anywhere in the text. 

b. drag the pointer over the text. 

c. place the insertion point in the text and press the F9 key twice. 

d. click Home  Select Text. 
 

 

____ 42. Moving selected text using Home  Cut and Home  Paste 

a. cuts the selected text and pastes it in at least two new locations. 

b. leaves the selected text and pastes a copy at the end of the document. 

c. has the same results as using Home  Copy and Home  Paste. 

d. cuts the selected text and pastes a copy into another place in the document. 
 

 

____ 43. Select text and then click Home  Copy to 

a. place a copy of the selected text on the Clipboard. 

b. place a copy of the selected text at the insertion point. 

c. delete the selected text. 

d. display a dialog box asking how many copies to place at the insertion point. 
 

 

____ 44. The first step in duplicating text is to 

a. click Home  Paste. c. select the text to be duplicated. 

b. delete the text. d. click Home  Cut. 
 

 

____ 45. When finding text with the Find and Replace dialog box, the search starts from the 

a. beginning of the document. 

b. position of the insertion point. 

c. beginning of the paragraph containing the insertion point. 

d. end of the document. 
 

 

____ 46. Which word will not be found using the search text side? 

a. roadside c. Sidewalk 

b. insidious d. insider 
 

 

____ 47. The size of text is measured in 

a. centimeters. c. inches. 

b. fonts. d. points. 
 

 

____ 48. Formatting text in a different font changes the 

a. shape of characters. c. characters to subscript. 

b. alignment of text. d. color of characters. 
 

 

____ 49. Subscript is a format that 

a. reduces the size of the text and raises it to the top of the current line. 

b. reduces the size of the text and lowers it to the bottom of the current line. 

c. enlarges the size of the text and raises it to the top of the current line. 

d. enlarges the size of the text and lowers it to the bottom of the current line. 
 

 

____ 50. The first step in formatting a word as bold is to 

a. select the word. 

b. click Home  Bold. 



c. place the insertion point to the left of the word. 

d. place the insertion point in the middle of the word. 
 

 

____ 51. Which is not a way to format selected characters? 

a. use the Mini toolbar 

b. click options in the Font group on the Home tab 

c. use options in the Office Button menu 

d. use the Font dialog box 
 

 

____ 52. A document can be previewed to 

a. see how the document will appear when printed. 

b. display the Mini toolbar. 

c. display the Print dialog box. 

d. display the Format tab. 
 

 

____ 53. A paragraph that is left aligned 

a. is positioned equally distant from the left and right sides of the page. 

b. has a jagged left edge and a straight right edge. 

c. has straight edges at both sides of the paragraph. 

d. has a straight left edge and a jagged right edge. 
 

 

____ 54. A paragraph that is right aligned 

a. is positioned equally distant from the left and right sides of the page. 

b. has a jagged left edge and a straight right edge. 

c. has straight edges at both sides of the paragraph. 

d. has a straight left edge and a jagged right edge. 
 

 

____ 55. A paragraph that is center aligned 

a. is positioned equally distant from the left and right sides of the page. 

b. has a jagged left edge and a straight right edge. 

c. has straight edges at both sides of the paragraph. 

d. has a straight left edge and a jagged right edge. 
 

 

____ 56. A hyperlink can be followed in Word by clicking the link while holding down the 

a. Alt key. c. Esc key. 

b. Ctrl key. d. Shift key. 
 

 

____ 57. In Word, the thesaurus can be used to 

a. create a new document with alternate words. 

b. check the grammar of a selected phrase. 

c. display a list of synonyms for a selected word. 

d. check the spelling of a selected word. 
 

 

____ 58. A synonym for sleep is 

a. alert. c. nap. 

b. aware. d. slope. 
 

 

____ 59. Where are thesaurus results displayed? 

a. in the document c. in the Save As dialog box 

b. in the Research task pane d. in a comment 
 

 

 

 



____ 60. Which feature in Word allows changes to a document to be recorded so that the original author can later  

  decide which changes to keep? 

a. automatic formatting of hyperlinks 

b. built-in thesaurus 

c. track changes feature 

d. document review feature 
 

 

____ 61. Which Word feature is not directly related to document collaboration? 

a. restricting changes c. adding comments 

b. tracking changes d. inserting special characters 
 

 

____ 62. Margins are 

a. the white region around the text on a page. 

b. located every 0.5" on the ruler. 

c. a paragraph format. 

d. the text on a page. 
 

 

____ 63. Setting an indent affects 

a. only the paragraph that contains the insertion point. 

b. the entire document. 

c. only the displayed page. 

d. only the sentence that contains the insertion point. 
 

 

____ 64. The default formatting for a paragraph is 

a. no space before and no space after. 

b. no space before and 10 points of space after. 

c. 10 points of space before and 10 points of space after. 

d. 12 points of space before and 12 points of space after. 
 

 

____ 65. The default line spacing for a paragraph is 

a. 1 line of space. c. 1.5 lines of space. 

b. 1.15 lines of space. d. 2 lines of space. 
 

 

____ 66. To double-space a paragraph, select 

a. 1.0. c. 2.5. 

b. 2.0. d. 3.0. 
 

 

 

 

____ 67. Which line of text is aligned according to the tab stops on the ruler above? 

a. 1. c. 3. 

b. 2. d. 4. 
 

 

____ 68. To remove an individual tab stop 

a. drag its marker downwards, off the ruler and into the document. 

b. double-click the marker on the ruler. 



c. select the tab stop in the Tabs dialog box and then type Delete. 

d. press the Delete key. 
 

 

____ 69. To select a vertical block of text, 

a. hold down the Shift key and drag. 

b. hold down the Caps Lock key and drag. 

c. hold down the Ctrl key and drag. 

d. hold down the Alt key and drag. 
 

 

____ 70. Which type of indent was used to format the following text? 

 
a. hanging indent c. right indent 

b. first line indent d. endnote 
 

 

 

 

____ 71. Which type and size of indent is illustrated in the graphic above? 

a. first line indent of 0.25" c. first line indent of 0.5" 

b. hanging indent of 0.25" d. hanging indent of 0.5" 
 

 

____ 72. A bulleted list should be used when 

a. each item is of equal importance. 

b. cutting and pasting. 

c. a list has more than two items. 

d. a priority of importance needs to be shown. 
 

 

____ 73. A numbered list should be used when 

a. each item is of equal importance. 

b. cutting and pasting. 

c. a list has more than two items. 

d. a priority of importance needs to be shown. 
 

 

____ 74. An area at the bottom of a page typically used to include information such as the page number, 

  date, or author’s name is called a 

a. bulleted list. c. header. 

b. footer. d. template. 
 

 

____ 75. Which would be the best keyword(s) to type in the Search for box in the Clip Art task pane  

  when searching for clip art that looks similar to: 

 

 
a. clip art c. butterfly 

b. computer d. graphics 
 



 

____ 76. To delete a selected graphic, 

a. press the Enter key. c. click Home  Delete. 

b. press the Delete key. d. drag it off the document. 
 

 

____ 77. Which button is used to trim away areas of a graphic? 

a. Picture c. Crop 

b. Picture Border d. Reset Picture 
 

 

____ 78. Which button is used to adjust the difference between the lightest and darkest areas in a graphic? 

a. Picture Border c. Crop 

b. Contrast d. Brightness 
 

 

____ 79. Which button is used to add effects such as bevels to a graphic? 

a. Border c. Picture Border 

b. Picture Shape d. Picture Effects 
 

 

____ 80. To insert a page break, press 

a. Shift+Enter. c. Alt+Enter. 

b. Ctrl+Enter. d. Shift+Page Down. 
 

 

____ 81. To delete a footnote, 

a. click Home  Delete. 

b. click Home  Delete Footnote. 

c. delete the footnote number in the text. 

d. delete the first word in the footnote reference at the bottom of the page. 
 

 

____ 82. A master document that includes the basic elements for a particular type of document is called a 

a. master. c. file. 

b. basic document. d. template. 
 

 

____ 83. Which file name extension is added when a Word document is saved as a Single File Web Page? 

a. .webx c. .htm 

b. .docx d. .mht 
 

 

____ 84. Which Word view is used to display a document saved as a Web page? 

a. HTML c. Full Screen Reading 

b. Normal d. Web Layout 
 

 

____ 85. Which part of the PowerPoint window displays the current slide number and the total number of slides? 

a. title bar c. Notes pane 

b. Ribbon d. status bar 
 

 

____ 86. Which part of the PowerPoint window displays notes that correspond to the current slide? 

a. Quick Access Toolbar c. Notes pane 

b. Slide pane d. status bar 
 

 

____ 87. Text, images, and other objects that appear on a slide are the 

a. content. c. thumbnails. 

b. layout. d. audience. 
 

 

____ 88. Fonts, colors, and accent graphics that appear on a slide are the 

a. content. c. thumbnails in the presentation. 

b. contrast elements. d. design of the slides. 
 

 



____ 89. The arrangement of text and images on a slide is the 

a. content. c. design. 

b. layout. d. thumbnails. 
 

 

____ 90. New slides are added 

a. before the current slide. 

b. after the current slide. 

c. as the last slide of the presentation. 

d. as the first slide of the presentation. 
 

 

____ 91. The AutoFit feature automatically 

a. sizes a graphic proportionately. 

b. resizes text to fit in a placeholder. 

c. resizes a slide to accommodate the text. 

d. resizes a slide when it is projected. 
 

 

____ 92. Text on a slide is edited by 

a. adding a slide transition. 

b. selecting the Edit button on the toolbar. 

c. clicking a placeholder to place the insertion point and then typing. 

d. typing in the Notes pane. 
 

 

____ 93. Which is a good font choice for large amounts of text? 

a. sans serif c. decorative 

b. serif d. italic 
 

 

____ 94. Which view divides the window into the Slides and Outline tabs, Slide pane, and Notes pane? 

a. Normal view c. Slide Sorter view 

b. Outline view d. Slide Show view 
 

 

____ 95. Which view displays thumbnails of all the slides in the presentation? 

a. Normal view c. Slide Sorter view 

b. Outline view d. Slide Show view 
 

 

____ 96. The order of slides in a presentation can be changed in Slide Sorter view by 

a. typing the new order in the Print dialog box. 

b. dragging a slide to another position. 

c. displaying the Slide Master. 

d. clicking View  Order. 
 

 

____ 97. Which view is useful for changing slide order and selecting multiple slides? 

a. Normal view c. Slide Sorter view 

b. Outline view d. Slide Show view 
 

 

____ 98. Which key is pressed to start Slide Show view? 

a. F1 c. Enter 

b. F5 d. spacebar 
 

 

____ 99. Which view displays the current slide in full-screen size? 

a. Normal view c. Slide Sorter view 

b. Outline view d. Slide Show view 
 

 

____ 100. During a slide show, pressing the Esc key 

a. displays the last slide. c. ends the slide show. 



b. displays slide 1. d. displays the previous slide. 
 

 

____ 101. During a slide show, pressing the N key 

a. displays the last slide. c. displays the next slide. 

b. displays slide 1. d. displays the previous slide. 
 

 

 

 

____ 102. The images above are examples of 

a. slide layouts. c. slide masters. 

b. themes. d. animations. 
 

 

____ 103. Which Print Preview  Print What option prints one slide per page? 

a. Slides c. Notes Pages 

b. Handouts d. Outline View 
 

 

____ 104. Which Print Preview  Print What option prints a specified number of miniature slides? 

a. Slides c. Notes Pages 

b. Handouts d. Outline View 
 

 

____ 105. Insert  Clip Art is used to add 

a. a digital camera picture. 

b. a scanned picture. 

c. a graphic created by an artist using illustration software. 

d. WordArt. 
 

 

____ 106. Which color combination would be the easiest to read? 

a. red background, black text 

b. light yellow background, light orange text 

c. dark blue background, white text 

d. dark green background, pink text 
 

 

____ 107. Which application would most likely be needed to copy a chart? 

a. Word c. Access 

b. Excel d. Outlook 
 

 

____ 108. Which is used to change the look of printed speaker notes? 

a. Slide Master c. Notes Master 

b. Speaker Master d. Handouts Master 
 

 

____ 109. The way one slide changes to the next in Slide Show view is called the 

a. slide transition. c. slide number. 

b. slide footer. d. animation. 
 

 

____ 110.  

The image above contains examples of 

a. slide transitions. c. themes. 

b. slide orientations. d. layouts. 
 

 



____ 111. The way items move onto a slide is called 

a. the slide transition. c. the slide speed. 

b. animation. d. the color scheme. 
 

 

____ 112. To have titles fade in one by one during a slide show, apply 

a. a slide transition. c. a transition speed. 

b. an animation. d. a slide layout. 
 

 

____ 113. Fade, Wipe, and Fly In are examples of 

a. slide transitions. c. slide speeds. 

b. animations. d. themes. 
 

 

____ 114. Markings made on a slide during a slide show are called 

a. slide transitions. c. annotations. 

b. slide animations. d. footers. 
 

 

____ 115. A master presentation that includes the basic formatting and elements for a particular type  

  of presentation is called a(n) 

a. annotation. c. theme. 

b. template. d. HTML file. 
 

 

____ 116. Which is not a PowerPoint compatible sound format? 

a. MPEG c. WAV 

b. MP3 d. PPTM 
 

 

____ 117. Which is not a way to add sound to a PowerPoint presentation? 

a. add a sound from the Clip Art task pane 

b. record sound using a connected microphone 

c. select a sound from the Sound Gallery group on the Insert tab 

d. play music from a CD 
 

 

____ 118. Which is not a PowerPoint compatible movie format? 

a. AVI c. MPEG 

b. PDF d. MPG 
 

 

____ 119. Which is not a way to deliver a presentation? 

a. publish the presentation to the Web 

b. save it on a hard drive 

c. have a live speaker narrate while the presentation is projected onto a screen 

d. play the presentation in a continuous loop 
 

 

____ 120. Which PowerPoint feature is used to create a slide show of pictures? 

a. animation c. movie 

b. photo album d. templates 
 

 

____ 121. Desktop publishing creates a file called a 

a. document. c. workbook. 

b. publication. d. database. 
 

 

____ 122. Which is not used to select commands and perform actions? 

a. title bar c. toolbars 

b. menu bar d. Objects toolbar 
 

 



____ 123.  

The objects shown above are found in the 

a. Getting Started window. c. Design Gallery. 

b. My Templates window. d. Clip Art task pane. 
 

 

____ 124. Which is the Text Box tool? 

a. 
 

c. 
 

b. 
 

d. 
 

 

 

____ 125. Which key is used to zoom into a selected object? 

a. F1 c. up arrow key 

b. F9 d. Page Up key 
 

 

____ 126. To delete a selected graphic, 

a. press the Enter key. c. press the Esc key. 

b. press the Delete key. d. drag it off the document. 
 

 

____ 127. A publication can be previewed to 

a. see how the publication will appear when printed. 

b. add a graphic. 

c. display the Print dialog box. 

d. add a header. 
 

 

____ 128.  

How many pages does the publication contain given the image above? 

a. 1 c. 3 

b. 2 d. 4 
 

 

____ 129. What does  indicate? 

a. the current text box is selected. 

b. text can be typed. 

c. there is text in overflow. 

d. the pointer can be dragged to create a new text box. 
 

 

____ 130. Connecting text boxes means 

a. the boxes physically touch each other. 

b. the layout is placed in even columns. 

c. text flows from one text box to another. 

d. there are similar text boxes in two separate publications. 
 

 
 

 



Completion 

Complete each statement. 

 

 131. To erase the character directly to the left of the insertion point, press the ____________________ key.  

 
 132. In an inch, there are ____________________ points. 

 
 133. The alignment that creates straight edges on both sides of a paragraph is called ____________________. 

 
 134. To show a priority of importance, a(n) ____________________ list is used.  

 
 135. Word numbers endnotes with lowercase ____________________ numerals. 

 
 136. The file format for documents that are viewed using a browser is ____________________.  

 
 137. A smaller version of a slide is called a(n) ____________________. 

 
 138. The difference in lightness and darkness of two colors is called the ____________________. 

 
 139. Office, Metro, Flow, and Median are examples of ____________________.  

 
 140. When collaborating on a presentation, ____________________ can help explain edits.  

 
 141. A slide ____________________ is the way one slide changes to the next in Slide Show view. 

 
 142. A visual effect in which objects appear to move is called ____________________.  

 
 143. Markings or notes made on a slide during a slide show are called ____________________.  

 
 144. A master presentation that includes the basic formatting and elements for particular types of presentations is called a(n) ____________________.  

 
 145. An animated ____________________ is a file with several images that display in sequence and appear animated.  

 
Matching 

 

Match the letter with the corresponding type of alignment: 

 

 



 

____ 146. center alignment  

 

____ 147. left alignment



 


